
HP2 EXTENDED DOC 



HP2 PC - EXTENDED MOD 
version 2025-10-12 - Read changelog here. 

Created by DivingDeep39 and Liuke Withoutacoolname 

Download and basic instructions on the next page.​
For more detailed installation instructions, click here. 

For general info about the mod’s content, click here. 

To resources, click here. 

To mirrors, click here. 

CONTACTS 
If you have any question or if you experience any issue with the Extended Mod or the new 

M212 Engine/Editor, please reach us at: 

●​  Harry Potter Modding Discord server: https://discord.gg/2HG6Q7Ypau 

●​  HP-Games.net Group 13+ Discord server: https://discord.gg/VRCxCGFtHX 

●​  E-mail: divingdeep39@gmail.com (you might still be directed to the HP Modding Discord server) 

If you wish to know more about Harry Potter modding resources, visit 

HarryPotterUnrealWiki or join the Harry Potter Modding server on Discord.  

https://drive.google.com/file/d/12Cg02gIcn4JxnSdft9SiKTRyUBsiLEQL/view?usp=sharing
https://drive.google.com/file/d/12z18IgVNRvASNR0b4JG5fmu9nC8atw62/view?usp=sharing
https://drive.google.com/file/d/11NLd7EYdW_4Rk4eRxIuCIbM5blPfhFKF/view?usp=sharing
https://drive.google.com/drive/folders/1AdzYPPnbifFxrYiOn6rpT_EjGQ2TpYgu?usp=sharing
https://drive.google.com/file/d/14-jgx8Ih3tiYxRku3Satg5foaahJoNDU/view?usp=sharing
https://discord.gg/2HG6Q7Ypau
https://discord.gg/VRCxCGFtHX
https://github.com/metallicafan212/HarryPotterUnrealWiki/wiki/Main-Resources
https://github.com/metallicafan212/HarryPotterUnrealWiki/wiki/Main-Resources
https://discord.gg/2HG6Q7Ypau


BASIC INSTRUCTIONS 

1.​ Install “Harry Potter and the Chamber of Secrets” for PC in your desired available 

language. Virtual disc copies here. 

2.​ Download and install the latest version of Metallicafan212’s Harry Potter 2 Engine & 
Editor. If you need detailed instructions, click here. 

3.​ Download the latest HP2 Extended Mod version from below: 

3.1.​ Main Package (includes the English language). 

3.2.​ Language Package for non-English game versions: 

FULL AUDIO & TEXT TEXT ONLY HYBRID DUB OR 
NON-OFFICIAL 

DANISH (dan) GREEK (gre) POLISH (pol) 

FINNISH (fin) KOREAN (kor) PORTUGUESE (BR) (bra) 

FRENCH (fre) CHINESE (sim/tra) (n/a) RUSSIAN (rus) 

GERMAN (ger) CZECH (che) (n/a) UKRAINIAN (non-official) 

ITALIAN (ita) THAI (tha) (n/a) More non-official… 

JAPANESE (jap)   

PORTUGUESE (PT) (por)   

SPANISH (spa)   

DUTCH (dut) (n/a)   

NORWEGIAN (nor) (n/a)   

SWEDISH (swe) (n/a)   

3.3.​ (Optional) Add-On Levels (read changelog here): 

●​ Flying Car Quest (Adv0FlyingCar). 

●​ New Boomslang Skin Quest (Adv4GreenhouseOld). 

●​ Hospital Wing Quest (Adv10Hermione). 

4.​ Extract the content of the package(s) into the game folder, overwriting anything it 

requires (in case, extract the optional Add-Ons last). 

5.​ In the System folder, double click Game.exe to run the game. Enjoy! Remember to 

repeat steps 3 and 4 after updating the M212 Engine, and always start a new game! 

Click here for Updating the M212 Engine and the Extended Mod, Uninstalling, Debug 
Mode, and FAQs & Troubleshooting. 

https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://drive.google.com/file/d/12z18IgVNRvASNR0b4JG5fmu9nC8atw62/view?usp=sharing
https://drive.google.com/file/d/1CYiupF8rsmMT7ksr4ylXTC7l6JqkadxE/view?usp=sharing
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg
https://drive.google.com/file/d/1o7sBdfIDBtFFiGzTZg3XEbkQyEMX89j6/view?usp=sharing
https://drive.google.com/file/d/1DdJyRfuNas8aPLZcdTftUkaP0MGTWym3/view?usp=sharing
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg/file/CKQxFRjZ
https://drive.google.com/file/d/1GTTdC084fVIesnGZEpnu3P_yv_z-uJFt/view?usp=sharing
https://drive.google.com/file/d/13TYmxqRXXeFfyKbUFTBdRxOAGo5tctJT/view?usp=sharing
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg/file/6WIDHBrS
https://drive.google.com/file/d/1Qa2WQr9Nz4mmDp-LBHfvJaI6L8aDOzJU/view?usp=sharing
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg/file/3XZRCR5b
https://drive.google.com/file/d/1Zwnr6L7ykahj1wTbNdlmZy4SWOU0opgF/view?usp=sharing
https://mega.nz/folder/PPw1nQCC#LvODL7d3ep1E0U8g8bjvHg/file/yaYnGTLQ
https://drive.google.com/file/d/1peGCNsZYjjdArA6inVbXmYibAv5dj09b/view?usp=sharing
https://drive.google.com/file/d/12sMliGhiZ7LHFtenBaWrNKZcXnf99FrI/view?usp=sharing
https://drive.google.com/file/d/1OeDJ4CUATe94nJnDC4lBsNj4DcK61VIU/view?usp=sharing
https://drive.google.com/file/d/1DQtMGzTACf6EAYplQkRIdCvCbR1GMtNU/view?usp=sharing
https://drive.google.com/file/d/1S4ofmFLCR4dX0s-37iLr9lOsp3KyKrLI/view?usp=sharing
https://drive.google.com/file/d/176A7u3YY7H1HFyK2TfcVZ36Z017WVRhB/view?usp=sharing
https://drive.google.com/file/d/1k-icklFh8VQfOWBcLmdDfNGQuqa17Cq1/view?usp=sharing
https://drive.google.com/file/d/1r6uOYeI4Qk8ry3nQPmczYlQYtxoFEXXu/view?usp=sharing


VIRTUAL DISC COPIES 

Despite the “Harry Potter” intellectual property having copyright holders (Warner Bros), the 

Harry Potter video games published by EA Games (or Electronic Arts) are considered 

abandonware to this date. 

This means that, due to legal issues between the game publisher and the IP holders, the EA 

Harry Potter games (including “The Chamber of Secrets”) are no longer supported and are 

not on sale anywhere. 

The only way to obtain the games is via the second-hand market (used physical disc copy) or 

the Internet Archive (virtual disc image). Piracy would not be tolerated if the games were 

officially sold through retailers or digital stores, but unfortunately for the EA Harry Potter 

games this hasn’t been the case since 2013 circa. 

If you don’t own the physical disc or you no longer have a disc drive, you can get a virtual 

disc copy from the Internet Archive. Thanks to the Harry Potter Games Archive Project, the 

Internet Archive now has many EA Harry Potter games available obtained through 

purchasing the original disc and dumping it in a way that preserves as much quality and 

information as possible. 

Here is the link to the Harry Potter Games Archive Project on Internet Archive, and below 

are the links to HP2 PC games in various languages. In Download Options, click Show All, 

and then click to download the .bin and .cue files. Then, use WinCDEmu to mount the .bin file 

and run the installer. When requested, enter the code 4551-3253204-0150067-4314. 

●​ English (UK), French, German 

●​ English (US) 

●​ Italian, Portuguese (PT), Spanish 

●​ Czech, Greek 

●​ Danish, Finnish 

●​ Japanese 

●​ Korean 

●​ Polish 

●​ Portuguese (BR) 

●​ Russian 

 

https://archive.org/details/@harry-potter-archive
https://archive.org/details/harry-potter-et-la-chambre-des-secrets-pc-game-french
https://archive.org/details/harry-potter-and-the-chamber-of-secrets-pc-game-north-american
https://archive.org/details/harry-potter-e-la-camera-dei-segreti-windows-pc-game-italian
https://archive.org/details/harry-potter-a-tajemna-komnata-ibm-pc-cz-hp2-pc-czech-windows
https://archive.org/details/harry-potter-en-de-geheime-kamer-danish-finnish-pc-game
https://archive.org/details/harry-potter-and-the-chamber-of-secrets-hp2-cos-ibm-pc-japanese-keep-case-ea-best
https://archive.org/details/harry-potter-and-the-chamber-of-secrets-hp2-cos-ibm-pc-korean
https://archive.org/details/hpcos_202105
https://archive.org/details/pc-game-harry-potter-e-a-camara-secreta-full-iso
https://archive.org/details/hp2-cos-ru-softclub-ibm-pc


UPDATE THE M212 ENGINE/EDITOR 

Upon opening the Launcher (Game.exe), a 

popup window will ask if you want to go to the 

downloads page to get the latest update 

available. Click “Yes”, and you will be sent to the 

Google Doc for the M212 Engine/Editor. 

Download, run the installer and select the same 

folders you chose during the first installation. 

You’re advised to delete your User Directory in 

the process, to avoid compatibility issues. 

NOTE: apply the latest Extended Mod files after 

updating the M212 Engine and start a new 

game! Check the Extended Mod’s page for the 

latest version. 

UPDATE THE HP2 EXTENDED MOD 

Download and extract the content from the updated Main, Language, and Add-On packages 

into the game folder, and overwrite the existing files. Always start a new game! 

NOTE: some updates may require the latest M212 Engine/Editor version. Pay attention to 

any news about a new engine version. 

UNINSTALL THE M212 ENGINE AND THE MOD 

If you installed the M212 Engine/Editor in the original game folder, uninstall the game as 

usual and then delete all the M212-related folders (installation and user folder). 

If you installed the M212 Engine/Editor in your backup game folder, just straight up 

delete all the M212-related folders (installation and user folder). 

Either way, some files will persist on your PC (such as the Start Menu Folder). To remove 
the Start Menu Folder, do as follows: 

1.    Make sure “Hidden items” is enabled in File Explorer (View > Show/Hide). 

2.​ In the drive where you installed Windows (usually “C”), open the following: 

C:\ProgramData\Microsoft\Windows\Start Menu\Programs 

3.​ Inside Programs, you will find the M212 Engine’s Start Menu folder. Delete it. 

https://drive.google.com/drive/folders/1zO5h0y5Vwbd7kaQUFciZn5-dkpKO8U3v?usp=sharing


ENABLE DEBUG MODE 

To enable Debug Mode: 

1.​ Open the Launcher via Game.exe 
2.​ Go to Options > Game 

3.​ Tick “Enable Debug Mode” 

4.​ (Optional) If you wish to hide the green debug text at the top of the screen, tick 

“Disable Debug Text” 
5.​ Click “Back” twice to return to the main menu 

The keyboard button to open/close the System Console while in-game differs from region 

to region. Some will have to press the tilde ~ key, others will have to press the key on the 
right of the letter L. 

Here’s a few debug keys and commands that you might find useful: 

●​ Press the Del key to freely move the camera while the game is paused. Press the Del 

key again to resume the game and teleport Harry to the desired location. 

●​ Press the F4 key to open the Map Selector. You can select a level from the list, a 

GameState (or GState), and launch it. Press F4 again to close it. 

●​ Open the System Console and enter HideHud to toggle off/on all the on-screen icons, 

indicators, and cutscene bars. 

●​ Open the System Console and enter SilenceMessages to toggle off/on the green 

debug text (feature also available from the launcher). 

●​ Open the System Console and enter Stat Fps to toggle on/off the on-screen framerate 

counter. 

 



FAQs AND TROUBLESHOOTING 

●​ I GET ERRORS/CRASHES WHEN I TRY LAUNCHING THE GAME. 

NOTE: as of M212 Engine v3.4 (2025-08-29), old Extended Mod versions will cause 

crashes. Download the latest Extended Mod version, apply it, and start a new game. 

First, make sure your PC meets the minimum specs listed in the Google Doc for the 

M212 Engine/Editor. If so, check if you can launch the game in DirectX 9 mode by 

following the steps in THE GAME IS TOO LAGGY. 

If you still can’t get it to work, uninstall everything – also delete the User folder in 

Documents – and reinstall by following the correct order and steps: Base Game > M212 
HP2 Engine/Editor > HP2 Extended Mod > Optional Add-Ons. 

If despite this you keep having issues, please report your issue by joining the HP 

Modding Discord server. Keep in mind: A) saves from the base game ARE NOT 

compatible with the M212 Engine; B) saves made with an old version of the M212 Engine 

may not work correctly, so start a new game. 

●​ THE GAME SOFTLOCKS AT THE FLYING CAR LEVEL or AFTER QUIDDITCH 
PRACTICE or DURING POTIONS LESSON 

NOTE: as of M212 Engine v3.4 (2025-08-29), old Extended Mod versions will cause 

crashes and softlocks, preventing you from completing the game. Download the latest 

Extended Mod version, apply it, and start a new game. 

Either two things might have happened: 

A)   You applied the Extended Mod before installing the M212 Engine. 

B)   You updated the M212 Engine/Editor but you didn’t re-apply the Extended Mod. 

Either way, important files have been overwritten. You must re-apply the Extended 
Mod and start a new game. If the issue persists, uninstall and reinstall everything again. 

●​ I’VE LOADED AN EXISTING SAVE AND THE MOD IS ACTING STRANGELY/NOT 
WORKING. 

Similarly as above: 

A)  You updated the mod to the latest version and loaded an existing save. Start a 
new game. 

B) You updated the M212 Engine but you didn’t re-apply the Extended Mod. 

Important files have been overwritten, so re-apply the mod again and start a 
new game. 

https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://discord.gg/2HG6Q7Ypau
https://discord.gg/2HG6Q7Ypau


●​ DIALOGUE WON’T PLAY AND/OR SUBTITLES WON’T DISPLAY CORRECTLY. 
You didn’t apply the (correct) language package. Follow these steps to find out which 

localized copy of the game you own: 

1.​ Go to the game folder. 

2.​ Open the System folder. 

3.​ Open Default.ini via any text editor (MS Notepad, Notepad++, etc.). 

4.​ Under [Engine.Engine], search for "Language=". Take note of the three letters 

after the equal sign (ex., fre, ger, pol, rus, etc.). 

5.​ Download and apply the correct Language package. 

NOTE: Initials “int” and “usa” correspond to the English language included in the Main 

package. Check the mod compatible languages list here. 
  

●​ THE GAME IS TOO LAGGY (or it just won’t launch with DirectX 11). 
If you’re experiencing framerate drops or your game keeps crashing due to DirectX 11, 

make sure your PC meets the minimum specs listed in the Google Doc for the M212 

Engine/Editor. If the requirements are met but your graphics card has less than 4GB 

VRAM, switch to the DX9 renderer following these steps: 

1.​ Open the Launcher via Game.exe. 

2.​ Go to Options > Graphics > Render Device Options. 

3.​ In the top box, select “DirectX 9 Support” instead of the default “DirectX 11 

Support”. 

4.​ Click “Back” three times to return to the main menu. 

If despite this you keep having issues, please report them by joining the HP Modding 

Discord server. 

●​ THE LEFT AND RIGHT ARROW KEYS WON’T WORK. 
The new engine has disabled the left and right arrow keys by default due to the camera 

randomly tilting upwards at high frame rate. 

To enable the left and right arrow keys, open the menu in game (ESC key), go to the 

Input Menu (scroll icon, bottom left), and check the Keyboard Look checkbox (or Rotate 

with Arrow Keys in non-English localizations). 

https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://docs.google.com/document/d/1b_AsvqQtcTTLohgOdXqTHbC-oK6-KsD5ZeBuX4Usw2A
https://discord.gg/2HG6Q7Ypau
https://discord.gg/2HG6Q7Ypau
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